
 

 

 

 

Alpha-Xplorer 
C-Style Introduction 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
  

Vol.160829 



Alpha-Xplorer C-Style Introduction 160829.doc 

- 1 - 

Table of Contents 

 

C-Style Introduction 

1. System Preference  
1-1.System Requirement-------------------------------------------- 2 

1-2. Installing the USB driver ---------------------------------- 2 

1-3. Installation of C-Style ------------------------------------ 5 

1-4. Startup window ----------------------------------------------- 6 

1-5. Communication settings ---------------------------------------- 7 

1-6. Confirm the build path ---------------------------------------- 9 

1-7. The save mode used when building your program ------------------- 10 

2. Robot Operation Check 
2-1. How to activate movement check in the robot --------------- 12 

2-2. Sensor Monitor -------------------------------------------- 13 

3. How to program the robot 
3-1. Start to edit the program by clicking “NEW” -------------- 15 

3-2. Edit your program ------------------------------------------ 16 

3-3. Complete the program -- ------------------------------------ 17 

3-4. Save the program ------------------------------------------- 18 

3-5. Build the program ------------------------------------------ 19 

3-6. Download the program ------   ------------------------------ 20 

3-7. Completion of the downloading ------------------------------ 21 

3-8.Summary of Operation ---------------------------------------- 22 

4. Option Menu 
4-1.Showing program buttons on the right-------------------------- 23 

4-2.Hiding or showing C-Code ------------------------------------ 24 

4-3. Showing buttons -------------------------------------------- 25 

4-4.Motor power balance ----------------------------------------- 26 

 

 

5. CONTACT US ----------------------------------------------------------- 29 

 

 

 

 

 

  



Alpha-Xplorer C-Style Introduction 160829.doc 

- 2 - 

 
 

1． System Requirement 
1-1. System requirements 

 

C-Style is available on computers with WinXP, Win7, Win8, or Win10 OS. 

C-Style takes up 128 mb of memory.  

It will require 200mb of HDD when installed. 

It will use 1 USB port. 

 

  C-style will use a USB port to communicate to the robot, so please install another 

driver.  

 

 

 

 

 

 

 
 

 

 

 

1-2. Installing the USB driver 

The file installed from our home website is zipped, but if double clicked, should 

automatically create the folder “CStyleAX_Vyymmdd”. Inside that folder should 

be “CStyleSetup.exe”. Please execute that. 

 

There will be an installing menu. Please click “Driver Install” to install the 

USB driver.  

 

 

 

 

 

CAUTION！！ 

 

DO NOT CONNECT THE ROBOT AND THE COMPUTER 
WITHOUT INSTALLING THE DRIVER! 
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1 Click yes to the 

install conformation window, 

and start the driver 

installing wizard. 

2 Press next when you 

see this screen. 

Caution: When clicked, the 

window will take a little 

time to respond. 

 

3 When the install is 

finished, this screen will 

show up. Click finish, and 

you have successfully 

installed the dirver. 

 

 

4 Next, connect the USB 

serial adapter cable to a USB 

port on the computer. 

5 At the bottom right 

side of the computer a 

message should pop up as in 

the picture below. 

6 After a while, a 

message saying that the cable 

setup is complete will appear. 
The computer has recognized 

the USB driver. 
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For Windows 10, normally the computer automatically recognizes the USB cable with 

no messages above, once you plugged in. If you want to confirm the COM port number, 

just go to Device Manager and see PORTS. It shows Prolific USB-to-Serial Comm Port 

(COM ##) and ##is the number. 

 

 

Click to show COM ports 

Find “Prolific USB-Serial Com 

Port 

COM port number is this. 
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1-3. Installation of C-Style 

 

To install C-Style, click “C-style Install”. 

 

 
 

Then just click next and follow the install wizard. Then the install will be 

complete and you will be brought back to the main menu. 

 

 You can see the various instruction manual PDFs by clicking the “Documents” 

button. 

 

When the “close” button is pressed, the install menu will disappear. 

 

 

 

 

 

 

 

 

 

 

 

  

 

The newest version of C-Style is available to download on 

http://www.daisendenshi.com. 
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1-4. Startup window 
 

 

 
 

■System menu 

 

The tabs labeled “File”, “Project”, “Window”, and “Option” are called the 

System Menu. 

To open a program, save, print, or exit, the “File” tab is used. 

To build, download, regulate communication between the robot, and set build path 

settings the “Project” tab is used. 

When there are multiple sub programs, the “window” tab can be used to set how 

it is displayed. 

To monitor sensors, tweak robot functions, set special buttons, and to change to 

programming language C, the option tab is used.  

  The “Help” tab shows information about the current C-style version, and firmware 

version.        

  It also has the link to the newest C-Style download page. 

 

■Speed button 

 The most commonly used menus are buttons that are placed in the system menu. It 

is the same if you execute the actions from the system menu. 

  

Version of C-Style 

 

Program Editing Area  

Program Button List 

 

System Menu 

Speed Buttons 
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1-5. Communication settings 
 

    We will go over the settings to communicate with the robot. 

The settings will be saved, so you do not have to do this every time. However, 

if you change which port you plug in the adapter, you will have to do this 

step again. 

 

1 Before we configure the settings, please plug in the robot and turn it on. 

2 Go to Device Manager and click “Ports”  

3 As shown the above, find “Prolific USB-to-Serial Com Port (COMxx)” to confirm 

COM number. In this case, COM PORT number is 3 (The COM Ports number is depending 

on which USB port is inserted. 

4 When you launch C-Style and click the project under the system menu, and select 

“Communication Settings” 

5 When the dialog of the “Communication Settings” popped up, click the pulldown 

menu of COM port settings, to select the Com port number (in this case above: 

COM3) and click ok. 

 

 

 

  

Click here to show the list of COM PORTS 

Find the name of the driver made by Prolific 

This is the number of the COM Port set in the 

COM port setting in C-style. 
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How to select the COM Port in Device Manager in C-Style. 

 

 

 

 

 

1.When you launch C-Style and click the project 

under the system menu, the project menu will pop 

up. 

 

 

 

 

 

2.The dialog for the communications 

settings will be shown. 

 

 

 

 

3. Select the COM port. 

 

 

 

 

 

 

 

 

 

 

4. Click Ok to finish. 

 

 

 

 

 

 

 

 

 

 

  

If the robot is not plugged in or 

turned on, a warning signal will pop 

up. Turn on or connect the robot and 

press “Yes” to search for the port 

again. 

 If you want to set COM9-COM99, click 

“COM PORT” to reload the list to 

select. 
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1-6. Confirm the build path 

When you build the C-Style program, the path settings will check the batch file 

location. 

1 Click on the project menu 

 
 

2 When you select build path, it will show“C:\Daisen\.. .. \BuildAX_V160827\, if 

that is true, close the menu. 

 

 
 

3 If it is not there, or in future updates it is not “BuildAX_V160827\, click on 

the text on the right side of the build path 

4 The file open text will show up, so select the newest version folder, then open 

the “BuildPath.Bat” and open it up. 

 

5 When the screen becomes back to the main screen, you are all set! 

 

  

 

 

Select this file and press “Open” to 

complete the settings. 

Click here to look for the newest 

version of the folder. 

The name of the newest version 
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1-7. The save mode used when building your program 
 

If you build without saving, there are several option to save the program when you 

build it. 

 

1 Automatically save the current 

program. 

2 update the new program to the old 

save 

3 Create a new file for the new 

program. 

These are the saving options when you 

build your program.。 

 

 

The default setting for saving when building is to update the new program to the 

old save 

 

 

 

 

 

 

 

 

 

 

 

 

 

If “Yes” is selected, then you will be returned to the build screen. 

If No is selected, you will not be return to the build screen. 

 

To change the save mode of the save options, click “new” in the button and click 

“Yes” to change the save mode. You will be returned to the build screen after the 

program is saved. 

 

If you select “update the old save” then whenever you click the build button, it 

will update the save and return to the build screen. 
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If you choose to create a new file, the names will include the date, and will create 

a new file every time you build a program 

First saved file “NewFile-00.Csy” 

2nd saved file “NewFile-00_#001-150619-190316.Csy” 

3rd saved file “NewFile-00_#002-150619-190455.Csy” 

 

Format for including time “FileName_#nnn-yymmdd-hhmmss.Csy” 

FileName：the first saved file（任意） 

_#nnn：number of times buit（001～999） 

yymmdd：year 

hhmmss：seconds 
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Robot Operation check 
 

2-1. How to activate movement check in the robot 
 

You can activate the movement check program anytime, separate from other programs 

in the robot. 

Normally, turning the machine on, and pressing the start button would start the 

program, but the movement check program is activated differently. 

 

1 Check if the batteries are facing the right direction 

2 Press the start button, then turn on the machine while pressing the start 

button. 

3 Do not release the start button until the green LED blinks rapidly. 

4 When the green LED blinks rapidly, let go of the start button.(The movement 

program will start) 

5 First, the green LED will blink, then orange, then red, then the front left, 

the right. After that, the green LED will blink slowly. 

6 When you put a white object near the line reflection sensor in the front, 

the orange LED will blink. 

7 If you press the start button again, the motor rotation program will start. 

The robot will go forwards, backwards, left and right then stop. Then it will 

loop to number⑤s LED program again. 

8 This will repeat until the machine is turned off, so you can check the working 

condition of the robot. 

9 Press the start button to go back to step ② 

 

 

If your program doesn’t work, try the movement check program to check if the robot 

is working. If the movement check works, it is something to do with your custom 

program. 
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2-2. Sensor monitor 
 

You can check if the sensors on the robot are working properly 

 

1 Connect the robot and your computer with the serial cable and turn the robot on. 

2 You can open the sensor monitor by clicking the sensor monitor button. 

 

 

 

This is the sensor monitor screen. (At this point, the sensors should not be 

returning numbers yet) 

3 When the “moniter start” button is clicked, a chime will sound and the 

monitering will begin 
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Monitoring sensors 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
In default settings, the CN1 will tell you how much the infrared light is left, the CN2 will 

tell you how much the infrared sensor is receiving light form the right. CN3～CN9 will monitor 

optional sensors when they are hooked up. 

BATT s the amount of power the battery has left. 

The bar graph will turn green when the robot has 4+volts, orange when it has 3.4-4v, red is 

below 3.4 volts 

 

The sensor displays the percentage, and A/D converter numbers. (0-4095) 

The the robot's microprocessor converts the analog sensor signals into a 12-bit digital 

number between 0-4095.  That value is used when the signal is saved in a variable.  For 

example, if you program A = CN1, and CN1 reads a signal of 30%, then A will be 1228 or 1229, 

because 4095 x 30 / 100 = 1228.5 

 

4 To end the sensor monitoring, click the close button. 
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3. How to program the robot 
 

How to access the programming settings: “edit program” → “Save program” → 

“Build” → “Download” → “Robot settings” 

We will program the robot to go forward for 1 second. 

 

3-1. Start to edit the program by clicking “NEW”,

 
 

Click the block you want to place from the program button list and click your 

program to place the block. 

 

C-Style does not have drag and drop. 
  

 

Program Editing Area 

Program Button List 
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3-2. Editing your program 

■ Going forwards 
 

 
 

1 Click      from the program blocks list and click it. 

The button controls how fast and what directions the motors turn. 

2 If you click the motor block again, the same settings will appear to adjust the 

speed and direction of the motors. 

3 However right now we will not be adjusting the motors. Please press “OK” to move on. 

 

■ Implementing timers 

 
1 Click     from the program block list. 

This button will make the robot wait for a set amount of time. 

2 Click on a space were there are no blocks to place the timer. 

3 The timer will be the second block from the top. The timer settings will appear. 

4 The timer setting is set to 2 second, so we do not have to change it. Just press 

“OK” 
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■Stop the motor 

 
 

1 Click the       block again. 

2 Click an empty space to place the block in the third row. The settings will pop 

up. 

3 Click the motor icon at the center of the setting and click “OK” when it shows 

If you pass the STOP setting of the motor, you will be able to get it again by 

clicking until it appears again. 

 

3-3. Complete the program 

 
This program will make the robot move forwards 1 second and then stop. 

The next step is to build the program. When you click the build button, it will 

require you to set the name and location of the program to be saved. After saving 

the program, the computer will build, and download it to the robot automatically. 

If you only click the save button, the machine will not download the program to the 

robot. (Click build after you press save) 
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3-4. Save the program 

 
 

1 When you click the save button, you will have to enter the name and save location 

of the file. When you click the build button, the same dialogue pops up. 

 

2 You can save the file to any location, but the default is a file C-Style created 

called “User_AX” 

There are example programs inside the “User_AX” folder, so please try them out. 

In the “Study” folder, there are lots of basic programs already made. “Study_en” 

is the English version. 

 

3 You can name the file any name you want, but you can’t use ￥”、“＆”、“％”、

or “／”. 

 

4 If you already have a file named the exact name, then it will ask you if you 

want to overwrite the old file. 

 

The file name “NewFile-00.Csy”is going to be used every time a new program is 

made. Please make sure you name important programs with relevant names. 
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3-5. Build the program 
 

When you click build, the build screen will pop up. 

When you make a new program, after you save, this screen will pop up. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Click the build start button on the top left of the program 

2 The program gets translated into C-code, then becomes machine code. 

3 Please plug in the robot and turn it on before you press “OK” on the pop up 

that says “Build complete!” 

4 When you press “OK”, it will become a download screen. 
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3-6. Downloading the program 

When you click “OK” in the build completion pop up, it will turn into a download 

screen. 

1 Press “Start” on the download screen. 

 
 

 

If the robot is not connected or the 

robot is not turned on, then this error 

message will pop up. When you click 

“OK”, it will take you to step ① 

 

If you click “OK” without doing 

anything, it will ask you if you want 

to keep trying to download the program. 

“No” will cancel and put you back at 

the build screen. If you click yes, it 

will take you to the download screen, 

so please check if the robot is connected and it is turned on before you do 

this again. 
 

 

 

 

 

 

 

 

 

 

2 “Start” will start the download 

 
If the cable or robot is moved in this time, the download might fail, so do not 

touch it. 
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3-7. Completion of the downloading 
 

 
 

 

1 When the download is finished, detach the cable and test if the robot moves. 

2 check to see the green LED blinking, and press start to start the program. 

3 If you press Start again after the program is over, it will execute the program 

again. 

 

 

C-Style makes it a lot easier to program robots. 

Use C-Style to make more complicated programs and see if you can challenge yourself. 
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3-8. Summary of Operation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please challenge yourself little by little to make more and more complicated 

programs. 

 

New program Open program 

 

Save or overwrite 

program 

Edit the program 

 

 

build 

 

 

download 
If you save the program, the build 

button will automatically save the 

newest version and overwrite the old 

one. 
 

test 

Program finished 

Check the movement 

Downloading 

Building 

Programming 
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４．Option menu 

The option menu has lots of settings. 

 

”Sensor monitor” is the same one as the 

“Sensor monitor” in the speed buttons. 

 

“Show Grid lines” will show grid lines to make 

the program easier to read. 

 

“confirm deletion” will ask you for 

confirmation every time you delete a block. 

 

 

 

 

 

4-1. Show program buttons on the right. 
It will move the program buttons to the right. 

 

 

 

Left (Default） 

 

 

 

 

 

 

 

 

 

Right (Edited) 

 

 

 

 

 

 

 

  



Alpha-Xplorer C-Style Introduction 160829.doc 

- 24 - 

4-2.C-Code Show C-Code 
This option allows you to see the C-Code corresponding to the blocks on the 

right side of your screen. 
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4-3. Show buttons 

This will show the setup button for extra parts on the top right of the screen. 

 
 

 
 

If you select show setup button for the first time, it will launch the setup screen as well 

as add a setup button at the top right of the programming screen. 

 

The setup screen will be accessible by clicking the setup button on the top right of the 

programming screen. 

 

To hide the setup button, simply click Show setup button again in the option menu. 

Saved programs will save information about if the setup button is hidden or not. 
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4-4. Motor power balance 

Option to balance the output of motors 

 

 
 

■how to edit 

1 Download a program that makes the motors go forward at 50% speed for 2-3 seconds. 

2 Observe weather the robot turns slightly to the right or left. 

3 Plug in the robot and turn it on. 

4 Select the option “Motor Power Balance” and show this pop up. 

 

5 if the robot is connected, there is going 

to be input from the robot. 

 

The default setting will be Left:0 Right:0 

Center:5. 
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6. If the robot is moving left, slide the 

slider so that the right side is negative 

because the right motor is too powerful. 

 

7. If you click the download button, the 

robot will save these settings. 

 

8. Test if you adjusted the robot enough. 

 

9. If not, do these steps again to try and 

improve the balance. 

 

10 Repeat step 7 to download and test the results. 

 

■Next, we will test the balance when the motors are at 100%. 

 

 

11 Download a program that makes the robot go at   

100% speed for 2 seconds. 

 

12 Adjust for the robot again and click download 

to test again. 

 

13 Repeat this until you feel 

comfortable with the motor balance. 

 

14 Please check the left and right 

numbers before editing the central 

number 

 

Left and right numbers go from ０～ －

１００ but the central number goes only 

from 0-10. 

MEMO 1 
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Memo 
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Memo 
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Memo 
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５．Contact us 
 

 

 

 

 

 

 

 

 

 

 

Daisen Denshi Kogyo 
Osaka, Japan 

 
 

Distributed and Translated by 
ROBOMOV LLC 

252 Nassau Street, 
Princeton, NJ, 08542 

USA 
TEL: 609-865-9572 
www.robomov.net 

 
 
 
 
 


